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Tosa® (Test on Software Applications)  

Tosa assessments and certifications will determine and validate a candidate’s proficiency 

and skill level in software applications used in a professional environment. Tosa 

assessments and certifications are designed to validate individuals’ digital skills (students, 

trainees, employees, or jobseekers) in supporting their employment, professional or 

academic objectives.  

Tosa assessments and certifications employ the Adaptive Testing methodology, which 

creates a personalized testing experience adapted to a candidate’s skill level for a selected 

software application. The score is based on the Item Response Theory using a 3-parameter 

logistic model, like the GMAT scoring method. Adaptive-based testing selects questions that 

challenge candidates to the limit of their knowledge and abilities.  

Tosa Skills Framework Objective 

This Tosa framework provides an overview of the subject areas being assessed during the 

Tosa Assessment and Certification exams. The Tosa validates candidate proficiency in the 

most popular professional Office software programs using a score on a scale from 0-1000 for 

the Certification Assessment, and a score divided into five levels, from “Beginner” to “Expert,” 

for the Diagnostic Assessment.  

The objective of this document is to present an overview of the technical skills associated 

with each of the four main Microsoft Word domains within each proficiency level. This 

information will also support educators and trainers in tailoring their training program to 

achieve desired proficiency levels.  

Unique Tosa Scoring  

The Tosa assessments and certifications are based on a unique score, divided into five levels. 

• ranging from 1 to 1000 for the certification. 

• divided into five levels, from Beginner to Expert, for assessment. 
 

Tosa® levels 
Corresponding 
Tosa® score 

Certification status & documents issued 

Expert 876 - 1000 
Certification earned - diploma & Credly 
digital badge issued 

Advanced 726 – 875 
Certification earned - diploma & Credly 
digital badge issued 

Productive 551 – 725 
Certification earned - diploma & Credly 
digital badge issued 

Basic 351 – 550 Certification earned – diploma issued 

Beginner 1 – 350 
Certification failed - certificate of 
completion issued 
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Word domains and subdomains 

 

Environment/ 

Methods 

◼ Knowing and customizing the display mode 

◼ Knowing and customizing the software environment 

◼ Using the basic functions of the software 

Page Layout and 

Formatting 

◼ Applying formatting options to texts with fonts 

◼ Using layout tools on paragraphs 

◼ Creating, handling, and customizing styles in documents 

◼ Using layout options 

Editing Tools 

◼ Using and handling automation tools in documents 

◼ Using entry-aid tools 

◼ Managing selection and displacement in a document 

◼ Inserting and customizing references in documents  

Graphic Objects and 

Tables 

◼ Using graphic objects tools 

◼ Managing tables 

◼ Inserting and modifying graphic objects 

 

About the Word certification 

The Tosa Word Certification relies on a database of more than 300 questions. It is composed 

of 35 questions and lasts 1 hour. The algorithm adapts to each answer of the candidates to 

adjust the difficulty level of the questions until they reach the exact definition of the 

candidates’ level by calculating the limit of their high skills. 

 

Since the test is adaptive, the series of questions that each candidate gets is unique for each 

test. This uniqueness allows for a more accurate evaluation of the candidate's level. It also 

limits cheating and the memorization of questions on different passages.  

 

Our platform allows individuals to take the certification in class, in an approved testing center, 

or remotely via our integrated asynchronous online proctoring solutions.              

 

Our remote proctoring solutions provide added flexibility for both the administrator and the 

candidate, allowing the certification exam to be taken anywhere, at any time. The candidate 

only needs an internet connection and a computer equipped with a working webcam and 

microphone. 

 

Candidates receive a numeric score out of 1000 points associated to a proficiency level on a 

five-level scale. Candidates who score between 1 and 350 points don't earn the certification. 

They will not receive a diploma but a certificate of completion. Candidates who score 351 

points or above earn the certification. They will receive a diploma by email within five (5) 
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business days. If candidates score 551 points or above, they will also be eligible to a Credly 

digital badge.  There is no requirement to be eligible to take the exam, but our 

recommendations to be well prepared on exam day are:  

 

- Take at least one Tosa Word adaptive assessment to estimate your level and get 

familiar with the test format 

- Use free practice tests on our website for training 

- Follow e-learning or training courses (average duration per level is between 10 and 

15 hours per certification so around 150 hours total)  

 

Tosa certification diplomas are valid for three years from the date of issue as skill levels evolve 

or decline over time, depending on the use of the software. New software and software 

versions are released every year, and skills must be updated. We cannot legitimately certify a 

digital skills level for more than three years. Limiting the certification validity reinforces the need 

for life-long learning and professional development.  

Tosa certifications can be retaken when it is expired. Earners willing to improve their score and 

level can also retake the exam at any time. 
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Tosa Sequence for Progressive Skills Development 

Students and professionals can tailor their certification journey with Tosa, demonstrating their 

expertise in ways that align with their unique needs and goals.  

With the Tosa Microsoft Word Certification, starting at a basic level, users can progress 

vertically, advancing to productive, advanced, and expert levels as their skills grow. This clear 

path encourages continuous improvement and validates each stage of their development. 

Tosa’s structure makes it easy to track progress and showcase evolving expertise. 

With the Tosa Microsoft Office Bundle Certification, users can expand their skill set 

horizontally across Microsoft applications, mastering interconnected applications that touch 

on a broader range of competencies. This flexible approach empowers individuals to develop 

both depth and breadth in their skillset, enhancing career prospects and workplace versatility. 

 

 



 

 

Level 1 – Beginner User 

Between 1 and 350 points 

 

  



Error! Use the Home tab to apply Titre 1 to the text that you want to appear here. 

All reproduction prohibited 8 

 

The Beginner Proficiency is set for a score from 1 to 350, which is the lowest Tosa score 

category. Achievement of Beginner score defines little or limited knowledge of the Word 

application, including the application’s basic functions and features, highlighting the inability 

to use the application in a professional environment. 

Overview 

Domain Skills Assessed 

 

Environment/ Methods 

 Open Word and open a document 

 Select text within a document 

 Save a document 

 Identify the ribbon tabs  

 

Page Layout and 

Formatting 

 Change font 

 Change font size 

 Change text color  

 Format text in bold or italics 

 Underline text 

 

Editing Tools 

 Cut, copy, and paste text 

 Use bullets (circles or numbers) 

 Convert lowercase to uppercase 

 

Graphics Objects and 

Tables 

 Insert a picture in a document 

 Insert a shape in a document 

 Insert a table in a document 



 

 

Level 2 – Basic User  

Between 351 and 550 points 
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Environment and Methods 

Interface 

Candidates demonstrate a basic knowledge of the Word environment. They know how to 

open the Word application and are familiar with the options available on the interface ribbon, 

the status bar, and the Quick Access Toolbar. They can open, save, and print a document. 

Methods 

Basic users can move around a document and go to a specific page. They know how to use 

the zoom feature and how to undo and redo an action using the corresponding keyboard 

shortcuts. 

Business application: For example, for an administrative assistant, these skills allow them to 

consult, record and even create new administrative documents such as meeting minutes. 

Page Layout and Formatting 

Text formatting 

Candidates can use most of the tab formatting buttons. This includes choosing different font 

types, changing the size of characters and text attributes (bold, italic, underline, highlighting), 

as well as text case. They can format text as superscript and subscript.  

Paragraph formatting 

Basic users know how to apply a predefined style to a paragraph and apply a predefined 

format to an entire document. They manage the alignment of paragraphs (left, centered, 

right, justified). They can increase and decrease text indentation using the buttons in the 

Paragraph group.  

Layout and preview before printing 

The basic level requires knowing how to choose a paper format; it also requires knowing how 

to display the Print Preview mode to get an overview of a document. 

Business application: For example, for an administrative assistant profile, be able to format 

an administrative document to make it easier to read and understand. 

  

*Prior to the acquisition of the skills of the Basic level, the candidate will have 

mastered the skills of the Beginner level. 
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Editing Tools 

Entering and editing text 

Basic users can copy, cut, and paste text and use the Format Painter tool to duplicate 

formatting. 

Paragraphs 

Candidates can insert a bulleted or numbered list. 

Finding text in a document 

Candidates can smoothly go to a specific page. They can perform a simple Find/Replace 

operation. They can view document statistics (number of pages, number of words, number of 

symbols). 

Business application: For example, on an administrative assistant profile, these skills allow 

the use of editing tools to modify and work on a document. 

Graphic objects and tables 

Inserting a table, working with cells 

Basic users can insert a table and enter text in cells. They can also insert and delete table 

rows and columns. 

Inserting and positioning graphic objects 

Inserting a graphic object (a shape or image) as well as resizing it with the sizing handles are 

skills acquired. Candidates also know how to position objects on the page using the layout 

option button or via the Arrange Group button. 

Business application: For example, for an administrative assistant, these skills allow them to 

insert simple illustrations and tables into your Word documents to complete and illustrate 

their administrative documents. 

Overview 

Domain Skills Assessed 

Environment/ 

Methods 

Interface: 

 Identify the Quick Access toolbar and the status bar 

 Identify the most common tabs and their main functions 

(File, Home, Insert, Create, Page Layout) 

 Select all the text of a document 

 



Error! Use the Home tab to apply Titre 1 to the text that you want to appear here. 

All reproduction prohibited 12 

Methods: 

 Create a document 

 Save and print a document 

 Use the zoom  

 Move within the pages of a document  

 Cancel and restore an action 

Page Layout and 

Formatting 

Text formatting: 

 Modify text attributes (bold, italic, underline…) 

 Change font size or text case 

 Make text superscript or subscript 

 Change font and text highlighting colors 

Paragraph formatting:  

 Use text alignment (left, center, right, justified) 

 Change the line spacing 

 Adjust paragraph spacing 

 Apply popular styles 

Layout and Preview before printing: 

 Print preview 

Editing Tools 

Entering and editing text:  

 Move text 

 Cut, copy, and paste text 

 Insert special characters  

 Copy formatting 

 Change the case 

Indentation of paragraphs:  

 Use simple bullet points and numberings 

Finding text in a document:  

 Use the Find box tool 

 Go to a specific page of a document 

 Review a document’s statistics  

Spelling corrector:  

 Identify the correction suggestions 
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Graphics Objects and 

Tables 

Inserting a table, working with cells:  

 Create a table 

 Input text in a table 

 Move throughout the table 

 Select, insert, delete, and move rows and columns 

Inserting and positioning graphic objects:  

 Insert an image 

 Insert a simple form 

 Resize and position a graphic object 

 



 

 

Level 3 – Productive User 

Between 551 and 725 points 
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Environment and Methods 

Navigation in Word 

Candidates move quickly from one page to another to reach a given page. They are also 

able to display the navigation pane to move faster within a document. 

Saving and printing documents 

Productive users can save a document in PDF format and know the rules of compatibility 

between documents from previous or later versions of the software. They master most 

printing options. They can print all or part of a text, specify the printing of even or odd pages 

and choose a printing format (A4, Letter, etc.). They can also insert a header or a footer. 

Business application: For example, for a secretary profile, these skills allow them to consult, 

create but also navigate within administrative documents while mastering the display and 

saving modes. The secretary can print documents for sharing with colleagues or for 

archiving. 

Page Layout and Formatting 

Fundamentals 

Candidates have a good knowledge of most of the formatting commands on the Home tab. 

They can apply different fonts and change text case (including toggle case), using 

strikethrough text. They can apply different underline styles, apply a predefined font style, 

and enhance titles.  

Paragraph formatting 

Productive users know how to change character spacing and increase or decrease 

paragraph spacing. They apply indentation and set tab stops with ease. They can add a 

border (lower, upper, left, right, outside, inside) and apply a shading to paragraphs. 

Page layout 

The productive level requires a good command of the tools for layout of a document. 

Candidates can explore and open the various predefined models of Word documents. They 

can change the orientation (portrait, landscape) and margins of a document by opting for the 

different predefined margins, and they also know how to structure text into columns. They 

can insert page breaks and page borders. They know how to manage word cuts at the end of 

the line, by activating or disabling the option Avoid Widows and Orphans. 

Business application: For example, on a secretary's profile, these skills allow them to 

customize the layout of a document to make the most of it and manage its appearance. 

Prior to the acquisition of the skills of the Productive level, the candidate will have 
mastered the skills of the Basic level. 
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Editing Tools 

Reviewing and editing a document 

Candidates can use Word's simple review functions like tracking, inserting, accepting, and 

rejecting revision marks, and Show/Hide Markup. They know how to display non-printing 

characters. They master the automatic verification tool for spelling and grammar. They can 

change the spellchecker language. They can use the Thesaurus tool and the Find and Replace 

functions. 

Document references 

Candidates can add or delete simple references to and from a document such as page 

numbers, headers and footers, footnotes, or endnotes. They can insert a table of contents and 

update it automatically. 

Automatic correction options tools 

Candidates can create simple personal automatic corrections and manage options when 

typing.  

Business application: For example, on a secretary's profile, these skills can be used to check 

and correct the spelling of a text, but also to annotate and structure it to make it easier to share 

with colleagues.   

Graphic objects and tables 

Tables 

Productive users demonstrate a good proficiency in table editing and formatting, and tables 

styles. They can format table cells, and merge or split cells. They can also add table borders, 

align cells, and change the width or height of rows and columns. They are familiar with the 

automatic column width adjustment tool. They can also add a header or total row. They know 

how to set tab stops in a table. 

Manipulating graphic objects 

Candidates can insert all the Word-compatible graphic objects- pictures, photos, shapes, 

SmartArt, and OLE objects from other Office applications. They can select and reposition 

them within a document and create simple drawing canvas using Word’s shapes. They can 

insert a legend. 

Business application: For example, on a secretary's profile, these skills allow the use of 

graphic objects and tables and their insertion within documents without compromising the 

formatting of the text. 
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Overview 

Domain Skills assessed 

 

Environment/ 

Methods 

Navigation in Word:  

 Master most common tabs and their functions (References, 

Review, View) 

 Use the navigation pane 

Saving and printing documents: 

 Recognize different modes of display and views 

 Use Play mode  

 View two documents side by side 

 Activate the scroll 

 Set print parameters 

 Save a PDF 

 

Page Layout 

and 

Formatting 

Fundamentals: 

 Know the commands of the Home tab 

 Apply different fonts and change text case  

 Apply different underline styles 

 Apply a predefined font style 

 Enhance titles 

Paragraph formatting:  

 Identify non-printing characters 

 Change character spacing 

 Use indentation and tabs (including adding leaders)  

 Manage borders and shading 

 Use text effects 

Page layout: 

 Use existing document templates and themes 

 Change document orientation 

 Change margins  

 Split the text into columns 

 Control pagination, and widows and orphans) 

 Insert a page break  

 Change page borders 

 

Editing Tools 

Reviewing and editing a document:  

 Manage revision marks (track changes, accept, reject changes) 

 Replace text 

 Find specific text or formatting 

 Perform a Paste Special operation 

 Use the replacement feature  

 Open PDF documents 
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Document references:  

 Insert page numbers 

 Insert headers and footers 

 Insert footnotes and endnotes 

 Create a Table of Contents automatically 

Automatic Correction Options Tools:  

 Create simple personal automatic corrections, manage options when 

typing 

 

Graphics 

Objects and 

Tables 

Tables:  

 Use table styles 

 Use cell formatting 

 Merge and split table cells  

 Use table tabulation 

 Add/delete column headers  

 Change borders and cell alignment 

 Insert a legend 

Manipulating graphic objects:  

 Insert OLE objects 

 Insert object images and pictures  

 Insert a SmartArt  



 

 

Level 4 - Advanced User 

Between 726 and 875 points 
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* 

Environment and Methods 

Customizing the environment and display 

Candidates can customize the application interface by creating new tabs and/or hiding those 

that are less useful to them. They can display the Developer tab, customize the Quick 

Access Toolbar, and program keyboard shortcuts. They know how to show/hide the ruler, 

gridlines, and thumbnails. 

Backstage mode and file formats 

Advanced users have an advanced knowledge of the File tab: they manage their files and 

related data. They can search for metadata or hidden information and set file options. They 

can access recent documents’ history and pin documents to the Recent Document list. They 

know how to share documents with different formats.  

Business application: For example, for a journalist, these skills allow them to use their 

documents when writing articles and to share them in the right format with their various 

colleagues. 

Page Layout and Formatting 

Editing tools 

The advanced level requires using advanced formatting tools, applying drop caps, editing 

themes and style sets, and inserting dummy text. 

Managing long document in Outline View 

Candidates know how to work in Outline View to best manage long documents. This includes 

creating a master document and adding subdocuments. They can also change heading 

levels and text formatting in Outline View.  

Page layout 

Candidates have thorough proficiency in the layout tools, including inserting a cover page, 

adding a document background, configuring page color and page borders, and inserting a 

watermark.  

Business application: For example, on a journalist's profile, these skills allow them to format 

their article as well as his/her page layout in order to structure and organize their text. 

Prior to the acquisition of the skills of the Advanced level, the candidate will have 

mastered the skills of the Productive level. 
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Editing Tools 

References in a long document 

Candidates can insert and edit a bibliographic citation, an index, bookmarks, cross-

references, hyperlinks, and footnotes. They can customize footnotes and manage pagination 

options (even and odd page headers). 

Correcting and translating a document 

At the advanced level, candidates must demonstrate a solid command of Word correction 

and translation tools and the Track Changes feature. They manage the different markup 

views (“Final: Show Markup”, “Final”, “Original: Show Markup”, “Original”). They know how to 

insert and manage comments. They can insert and edit document comments and can 

configure Translate tool and Mini-Translator options. 

Business application: For example, on a journalist's profile, these skills allow them to 

translate their article, correct it, but also to structure it (table of contents, index, etc.) and 

consolidate it (bibliography, notes, table of illustrations, etc.) 

Graphic objects and tables 

Tables and their layout 

Candidates can insert and manage any type of table, including a table from Excel. They 

master all the table style options (header, total, and banded rows; first, last, and banded 

columns). They can perform a calculation within a table and insert formulas. 

Editing an image or graphic object 

Advanced users master advanced tools for retouching and editing graphic objects. They are 

familiar with the various image cropping options (crop to shape, crop height or length). They 

can retouch and resize an image, rotate an object, remove the background of an image, or 

restore it in its original version. They can also adjust its brightness or colors and apply artistic 

effects and customize a shape via its edit points and manage text wrapping around a graphic 

object. 

Illustrate a text with graphic objects 

Candidates can insert all types of graphic objects into a document and know how to best use 

them to enhance a document appearance. They manage all functions of SmartArt. They can 

group objects, use text wrapping, or enter text in a shape. They know how to capture a 

screenshot.  

Business application: For example, on a journalist's profile, these skills allow them to manage 

graphic objects and tables. They know how to modify them and use the tools at their disposal 

to customize and modify them. 
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Overview 

Domain Skills assessed 

 

Environment/ 

Methods 

Customizing the environment and display  

 Master the Word interface and window 

 Manage the Outline View 

 Make perfect use of the navigation pane and Outline View 

Backstage mode and file formats: 

 Save files in various formats 

 Share a document in various ways 

 Manage files created in different versions of Word 

 Identify Word file extensions 

Automating tasks: 

 Run recorded macros 

 Use AutoText 

 

Page Layout 

and Formatting 

Editing tools:  

 Manage multi-level lists 

 Create drop caps 

 Use themes and style sets 

 Use dummy text 

 Edit styles 

Managing long documents in Outline View:  

 Create a master document and add subdocuments 

 Change heading levels in the Outline View 

 Develop and reduce the titles in the body of the document 

 Master pagination options 

Page layout:  

 Alternate page orientation 

 Add line numbers  

 Edit footnotes  

 Add a cover page  

 Save and re-use headings 

 Insert of a watermark 
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Editing Tools 

References in a long document:  

 Use the advanced table of contents options 

 Create a bibliography  

 Create an index  

 Create a table of figures  

 Add bookmarks  

 Add cross-references 

 Insert hyperlinks 

 Insert notes 

Correcting and translating a document:  

 Set up the spelling and grammar checker options 

 Perform a Fuzzy Lookup 

 Use the Mini-Translator  

 Configure translation options 

 

Graphics 

Objects and 

Tables 

Tables and their layout:  

 Perform calculations with tables 

 Insert an Excel table 

 Use table style options (header, total, banded rows) 

Editing an image or graphic object:  

 Retouch and resize an image 

 Edit points in a shape 

 Rotate an object 

 Delete an image background  

 Use advanced cropping 

 Restore the original size of an image  

Illustrate a text with graphic objects:  

 Manage SmartArt 

 Group objects 

 Use text wrapping  

 Enter text in a shape  

 Use image positioning tool  

 Capture a screenshot 

 

 



 

Level 5 – Expert User  

Between 876 and 1000 points 
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Environment and Methods 

Customizing the interface and display 

Candidates master the Word interface environment. They thoroughly know all the ribbon tabs 

and all their features and functions, including mail merge, the various Word views, and 

Outline view. They also master the Backstage view, the Quick Access Toolbar. 

They can set tab stops and have expert knowledge of the numerous “Save” options such as 

AutoSave, and printing options like setting page color and printing several document pages 

on a single sheet of paper. They are perfectly familiar with the Developer tab, can create 

complex macros, can use many file extensions such as. dox, .docm, .dotm, and .dotx. 

Sharing and protecting a file 

Candidates can manage all file protection options and are familiar with the “Mark as Final” 

and “Encrypt with Password” features. They can also restrict document editing (formatting 

restrictions, editing restrictions, start enforcement), and restrict who may edit a document. 

They master the PDF format whether it is reading or recording. 

Business application: For example, for an executive assistant, mastery of the Word 

environment and its tools allows them to customize their display in order to control all the 

options and tools useful in the production and management of their documents. 

Page Layout and Formatting 

Formatting 

Expert users have complete proficiency of all the page layout tools, even the most specific 

ones. Candidates know how to manage font themes and can customize them, applying 

special effects to text and Word and Quick Styles. They can also import styles from one 

document into another, create a list style and use the Style Inspector. They exploit the most 

specific font options, such as the application of a hidden font, or the options related to 

OpenType fonts. 

Page layout 

Candidates have an expert use of section jumps. They can create and format a section. They 

know how to customize a table of materials, manage with ease all the options of the headers 

and page footers as well as the watermark. They can create an indexing file. They also 

master all pagination options and can rotate a text. 

Business application: For example, on an executive assistant profile, these skills allow them 

to format and layout a Word document in order to write letters, reports, summary notes, etc. 

whose form is adapted to the recipient(s). 

Prior to the acquisition of the skills of the Expert level, the candidate will have mastered 

the skills of the Advanced level. 
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Editing Tools 

Complex editing tools 

Candidates master the review and reference functions. They use the most advanced Paste 

Special options and can create an exclusion dictionary. Candidates display a thorough 

mastery of Track Changes and its numerous options as well as all types of tables and 

references. 

Perform a mail merge 

Expert users can perform a mail merge and create a main source document, recipients list, 

or import a pre-existing list from Word or Excel. They can select and sort a recipients list 

based on criteria, insert merge fields, perform the merge, and create mailing labels and 

undertake calculations based on mail merge fields.   

Business application: For example, for an executive assistant profile, the mastery of editing 

tools allows the organization, structuring and exploitation of documents. 

Graphic objects and tables 

Managing graphic objects and tables 

Candidates have an exhaustive knowledge of graphic objects and tables, displaying a strong 

proficiency in the Selection and Visibility Pane. They understand anchors and their use in 

repositioning a graphic object or attaching it to a paragraph. They can easily manipulate 

shapes (notably flowcharts, stars, and banners), callouts, and use connectors and drawing 

options. 

QuickParts and forms 

The advanced level requires mastering Quick Parts building blocks, creating reusable 

content such as AutoText, document properties, and fields. Users can use the Building 

Blocks Organizer, create their own building blocks, and create a form with a dropdown list 

and prepare it for distribution. They can use ActiveX. 

Business application: For example, for an executive assistant profile, these skills enable 

them to master the insertion, modification and use of graphic objects and tables. They know 

how to use retouching tools and masters the different contents. 
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Overview 

Domain Skills assessed 

Environment/ 
Methods 

Customizing the interface and display: 

 Customize the Quick Access toolbar 

 Customize the ribbon  

 Manage thoroughly the various Word views 

Sharing and protecting a file:  

 Save from the developer tab 

 Protect and secure a shared document 

 Protect a document with a password  

 Merge and compare documents 

Page Layout 
and Formatting 

Formatting:  

 Edit a document template 

 Customize footnotes 

 Use the hidden font effect 

 Master OpenType font options  

 Use the Style Inspector  

Page layout:  

 Insert a watermark on a single page 

 Apply special effects  

 Create and format section differentiated headers and page footers 

 Expertly use page breaks, columns, and section jumps, and 

multicloning options 

 Create and manage links between text zones 

Editing Tools 

Complex editing tools:  

 Customize the table of contents 

 Manage the expert “find” operation 

 Create and use any type of building blocks (page headers, cover 

pages, tables, text areas, etc.) 

 Use of the ExcludeDictionnaryEN140c.lex 

 Create Quick Part content 

 Create a list style  

 Import styles from another document 

 Insert manage fields 

 Know everything related to automatic corrections, including Auto-

Math  

Perform a mail merge: 

 Create a main document 
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 Create a recipients list or use a pre-existing Word or Excel a 

recipients list 

 Select and sort mail merge recipients based on criteria 

 Insert merge fields 

 Perform the merge 

 Create mail merge labels 

Graphics 
Objects and 
Tables 

Managing graphic objects and tables:  

 Master Graphic object anchors 

 Use connectors 

 Use the Selection and Visibility pane 

 Manage thoroughly the image retouching tools 

 Manage thoroughly the building blocks  

 Master drawing areas 

QuickParts and forms:  

 Manage thoroughly the Quick Parts gallery and building blocks 

 Create a dropdown list in a template 

 Create and manage formulas 

 Use of ActiveX controls 



 

 

 
 contact@isograd.com 
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